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Now that you have installed ATS, you are ready to begin using the system. This brief Quick Start
Overview and the following User Manual provide the general information needed to begin entering
data into the system and using ATS for the first time.

ASSET TYPES AND CLASSIFICATIONS

This function allows you to create classifications and types within each classification. Classifications (i.e.
Office Equipment) and (sub-) Types (i.e. Desks, Chairs, etc.) are used to categorize assets. On the menu
bar select Support > Asset Support Administration. You can rename the Classifications and Types
designators in the Setup Options function if desired. See Asset Support Administration in the User
Manual for more information.

MAINTENANCE

The maintenance function of the system allows users to keep track of necessary maintenance for each
of their assets. Maintenance is tied to the different classes and types of the asset. On the menu bar,
select Support—=>Maintenance/Repair Provider Administration. See this section in the User Manual for
more detailed information.

CONDITIONS

Add any number of Conditions that you desire (Excellent, Good, Poor, etc.) This is a searchable field
and can be invaluable to locate equipment needing replacement, etc. See Support—=> Condition
Administration for additional information.

FUNDING SOURCE AND ACCOUNTS

The Funding Source is a standalone field that can be setup by you to use as needed. You can also
rename the Funding Source in the Setup Options function if desired. The Accounts screen allows you to
tie each Asset to an account number for added filtering. See Support—>Funding Source Administration
and Account Administration for more information.

FACILITIES

This function allows you to enter facilities, which are used to organize asset locations. On the menu bar
select Support—>Facility Administration. See Facility Administration in the User Manual for a detailed
explanation.

LOCATIONS

This function allows the user to create locations where assets are stored or to which assets are checked
out. Locations can also be classified as “Storage” locations. Storage locations are typically where
materials are centrally located until checkout. On the menu bar select Support—> Location
Administration. See Location Administration in the User Manual for a detailed explanation.
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EMPLOYEES

This function has you enter employees. An employee may be an individual that will be using the ATS
system or a person to which assets may be checked out. You can set ATS Access Rights for each
employee here also. On the menu bar select File>Employee Administration. See Employee
Administration in the User Manual for a detailed explanation.

MEMBERS

This function is used to create members other than employees. A member is an individual to which
assets may be checked out or assigned. You can set Member Categories in the Setup Options screen,
and then add members under the Members screen.

PRINTER ASSIGNMENT

This function allows the user to specify which windows printer will be used for report printing and
which one will be used for label printing. This function must be set on each workstation before
printing. On the menu bar select File>Printer Assignment. See Printer Assignment in the User Manual
for a detailed explanation.

LABEL DESIGN

The system allows the user to design labels for assets, locations, and employees. These labels typically
have barcodes and can be used to audit, check in, and check out assets. Several sample label designs
are included and can be modified. You must select a default label format in the Label Setup function
before printing is allowed. On the menu bar select Labels—> Label Designer. See Label Designer and
Label Setup in the User Manual for a detailed explanation.

ASSETS

The asset administration screen allows for the creation and history of assets which are tracked by this
system. On the main button bar select the Asset button. See Asset Management in the User Manual
for a detailed explanation.

Once you have setup your initial data, you are ready to start using ATS! Check out assets to employees
or locations. You can also check assets back “in” to storage. Be diligent on how you use the system and
it will provide years of reliable tracking of all of your assets!

Backup your database daily!
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- " Upon opening the program, the screen at left will appear.

Log In You will be prompted to enter a User Name and Password.
If it is the first time logging in, you will use the Admin
Enter your user name and password to log in. User’s data:
User Name: | Username: ADMIN
P Password: ADMINUSER

‘ _#U Exit ‘ Other users may be added to the system after setup. After
users are entered into the system, they should each log in

‘ .’ﬁ, Log In

under their own User Name and Password.

Registration g After logging in as Admin, click File on the menu and select

Registration Form. This step is important because it assigns

Registered Owner License
Customer IDENT: ||

licensing rights to you. Entering the information will unlock
the program for your licensed use.

License Key: | | | |

The Four Digit Customer Identifier and the 16 digit License
Key will be provided by Gigatrak when the product is
purchased.

[ cear ] [ Reomer | [ comol ]

After registering your product, click File on the menu and select Setup Options. (Setup Options can only
be accessed when logged in as Admin.)

L — This option can be used to change the
Setup Options f h f
Edition names of the parameters to fit your
" Starter (" Basic  Pro ' School .
needs This makes up the structure of the
Asset Setup (F1) Application Settings (F2) Member Setup (F3)

Rename Classification: ,W
Rename Type: [Type
Rename Facility: |Facility
Rename Location: |Location
Rename Funding Source: ,W
Rename Model Number: [Product Number
Rename Serial Number: [Serial Number
Rename Condition: 'W

system. Classification, Type, Facility,
Location, and Funding Source are
parameters tied to assets. Model
Number, Serial Number, Account, and
Condition can be renamed to suit your

Service Reminder Interval: [30 needs.
Root Image Folder: |C-\Users\AshlynnR\Docume B Report Auto E-mail Setup
Root Dacumnt Foldar (-] s If you would like to alter any of the
Custom Report Folder: B rom E-mat ress. . .
o | reto [ SMTP User Name: names, type in the desired value and
gigair&< SMTP Password: [ .
Use SSLTLS: I then click the OK button.
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The Service Reminder Interval is used to calculate when Asset Maintenance is due. The default setting
is 30 days.

The Root Image Folder is the default location for images that you wish to tie to an asset. If the image is
in the default location, only the file name is required in the asset screen to identify the image.

The Custom Report Folder is the location for custom report files. If a custom report is ordered, the
report file should be placed in a folder, and the path to the folder should be set in this option.

The Report Logo allows the display of a company logo on reports. You can select a .bmp, .gif, or .jpg file.
To clear a logo after it is selected, click the “Select” button and click Cancel on the selection screen.

Application Settings control various functions in the asset tracking application.
SHOW DEPRECIATION

P | S ———— L=/ = If Show Depreciation is checked, then the
Setup O
Edition

Depreciation Disclaimer

depreciation information will be visible on the

E

& starf | [This Depreciation Function, including access to formulas used for the computations provided P

herein, is provided by GigaTrak solely for your convenience and for illustration purposes only. H H

e ot s Yooy o Asset information screen. The Asset

financial reporting or accounting advice. GigaTrak does not guaranty the accuracy of

the computations. Furthermare, GigaTrak can not be aware of any customer's particular Hr H H
e | it A o ol s Depreciation Report will also be available on
I Allow] | |reporting or standards or -~ The contained herein is

not guaranteed to be carrect. complete or up to date. Accordingly. you should consult B
R Relog | 01 eut own lsgal tax. nsncial1zporting and acceunting advisors, GigaTiak s the Reports screen. If the checkbox is not
I~ Auto-|| |not responsible for any loss, injury, claim, liability or damage related to your use of this

Depreciation Function or the output hereof and by your use of this Depreciation Function P . . .
¥ Displf| |1 waive and release GigaTrak from any such loss, injury, claim, liability or damage CheCkEd, the de pFECIatIO n information will not
¥ Displ{| [You use this Depreciation Function at your own risk and the corectness and usability

of the output hereof remains your sale responsibility. b .. P .

e visible and the depreciation report will not

GigaTrak is not licensed or qualified to give, and is nat providing to you, any legal. tax, p p

financial reporting or accounting advice
[~ 8h
e : be shown.

© | agree to the terms of this disclaimer
© Ido not agres to the terms of this disclaimer The checkbox cannot be checked until you
OK H 1
7 accept the disclaimer.

After accepting the disclaimer, the Preferred
Depreciation Type selection will be enabled. This will be the default selection when adding new assets

on the Asset Information screen.

ALLOW DELETE ASSET & PURGE HISTORY

If checked, then the Delete button will be displayed on the Assets screen, and the Purge History button
will be displayed on the Asset History screen. If the checkbox is not checked, the Delete button and the
Purge buttons will not be displayed.

RELOCATE ASSETS

If Relocate Assets is checked, the Check In/Out function will change to a relocate function. This option
does not use storage locations and does not allow entry or tracking of binned items. Assets are
relocated from one location (or person) to another location (or person) without being returned to a
storage location.
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AUTO-POPULATE ASSET FIND TABS

When checked, the system will automatically display information when a Find screen is opened. If not
checked, you must first click “Extract Data” to view a listing.

DISPLAY EMPLOYEE BARCODES BEFORE NAMES

This applies to several report selection filters. If you view employees primarily by their names, leave
this unchecked. If you prefer tracking employees by the Barcode ID, then check the checkbox.

DISPLAY ACCOUNT NUMBERS BEFORE DESCRIPTIONS

The same rules apply to this option. Select how you prefer to view your report filters here. If you will
view accounts by descriptions, leave this unchecked. If you prefer tracking accounts by numbers, check
the box.

AUTO-CREATE “REPAIR” MAINTENANCE TYPE

Checking this box will insert a “repair” maintenance item any time a new Classification and Type of
equipment is created.

SHOW MAINTENANCE DUE REPORT AFTER LOG IN

By selecting this option, the report of any upcoming maintenance items automatically displays
immediately following log in.

SHOW BIN ASSETS BELOW REORDER POINT REPORT AFTER LOG IN

By selecting this option, the system will automatically display the report of any binned items below the
reorder point immediately following log in.

REQUIRE CHECK IN BEFORE ANOTHER CHECK OUT

Checking this box will require a checked out asset to be checked back in to the storage location before
it can be checked out again. Leaving this unchecked will allow an asset to be checked out from person
to person (or location to location) without being returned to the storage location.

SHOW MAINTENANCE ON HANDHELD

This option allows users to enter maintenance information on the mobile handheld terminal. If not
selected, the maintenance functions will not appear on the mobile handheld terminal.

AUTO E-MAIL EMPLOYEE UPON CHECK OUT

Checking this option will e-mail an employee a report of what they checked out through the system.
This feature can be used if you use Microsoft Outlook and connect the systems.
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The School Edition allows users to manage up B sy oy B2
Setup Options

to three types of “Members” of your own ——
yp y f‘d(smer " Basic " Pro @ School ﬁ oK
deflnltlon' ThIS COUId InCIUde FaCUItYl Staff, Asset Setup (F1) Application Settings (F2) Member Setup (F3)
Teachers’ Students’ etc. Show Members: @ Rename Member [Member
Category Names

H ename Cateqgol : uden

You can rename the Member field at the top of FErme e |l
Rename Category 2: |Faculty

the tab to your choice of field. Renaming the Ronams Casgory 3 [o0
field and saving changes will make the changes Addiionsl Information Fielda

Rename Info Field 1: [Subject
Rename Info Field 2. info Field2
Rename Info Field 3: [info Field3
Rename Info Field 4: [info Fieldd

consistent throughout the system.

Category names can also be renamed and act as
an additional field by which you can search

throughout the system.

The Additional Information fields give four optional searchable fields for members.

To save the changes for both tabs on the screen, select the OK button. A confirmation message will
appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen.
Selecting “No” will reset the changes back to the original values.

To leave the screen without changing any values, select the in the upper right corner of the
screen.

The printer assignment process is used to set the printer the system will use for printing reports and
barcode labels. Select Printer Assignment from the File menu and the screen below will be displayed.

- Printer Assignment E= The Available Printers list will display all the printers
Printer Assignment that are on the Windows printer list.
Available Printers
Nt Avaiiabio — | To select the report printer, select the printer of

Microsoft XPS Document Writer
Fax

WPTS3\Brother HL-2170W series . I .
HP Color LaserJet Pro MFP M476 PCL 6 button. The Default Printer label will indicate the
WebEx Document Loader b

choice and then click the Assign Default Printer

m

printer you selected. Any reports printed by the
‘ fjr? gesigmiabelnay system will be directed to this printer. This does not

Default Printer: HP Color LaserJet Pro MFP M476 PCL 6 affect the windows default printer selection.
Label Printer: HP Color LaserJet Pro MFP M476 PCL 6

[v—'%ﬂ/ Assign Default Printer

To select the label printer, select the printer of choice
and then click the Assign Label Printer button. The Label Printer label will indicate the printer you
selected. Any labels printed by the system will be directed to this printer. If you do not have a label
printer, assign the default printer to act as the label printer.
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Employees are either people that have access to the ATS system or people to whom assets will be
assigned. To manage employees, select Employee Administration under the File menu.

';’» Employee Administration

=3

Employee Administration

=]
Employee: | I Export To File

lv%b Add] I//‘ Edill [‘)\( Delele‘
IO Print Barcode List |

Jones, Sean
Owen, Miles
Smith, John
User, Admin
Wilson, Eric

Name Barcode
Doe, Mary

E005
E004
E001

E003

Active?

Yes
Yes
Yes
Yes
Yes

6 rows found

Upon initial setup, the only employee
will be the Admin user. You may Add,
Edit, or Delete employee information.

To Add a new employee, select the Add
button. The form will change as
indicated. The items in bold text are
required for all employees.

The system will not allow editing of the
last name, first name, middle initial, or
user name for Admin User.

To delete an employee, select the
employee and then select the delete
button.

If an employee is assigned an asset or has an outstanding reservation or is involved in a history record,
the system will not allow the employee to be deleted. Set the Status to inactive to prevent further use.

To print employee labels, select the employee(s) to be printed and then select the Print Label button. If
a label printer has been selected and if a default employee label has been designated (see Label

Designer in this manual), the label(s) will be printed.

For label printing, multiple employees may be selected. To select multiple employees, do one of the

following:

Drag the mouse over the employees desired while holding down the left mouse button.

Select the first employee by left clicking with the mouse. Select the last employee in a range
by holding down the Shift key and the left clicking on the last employee. All employees in
between will be selected.

Hold down the Control (Ctrl) key and select the employees you wish to print by left clicking
on each one with the mouse.
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Enter the appropriate employee information. A few fields have special requirements:

-, -
%, Employee Administration

Employee Administration

Employee Info

rﬂ Save

Firs%lame: |

Last Name: |

Middle Initial:

Barcode: |

Log in Name:

(Min. 5 characters)

Password:

(Min. & characters)

Phone: |

Alt. Phone: |

E-mail: |

Notes:

EMPLOYEE ACCESS LEVELS

The barcode entry must be unique. A barcode for an asset,
location, or employee cannot be the same. Keep the barcode
as simple as possible, only using a short combination of
capital letters and numbers. If you use the supplied barcode
labels, the employee's barcode must match the label placed
on their badge.

If the employee will be using the ATS system, he will require
a Log in Name and Password.

The Log in Name must be between 5 and 10 characters long.
It must be unique; no two employees may have the same log
in name. Log in names are not case sensitive.

A password must be between 5 and 10 characters long.
Passwords are not case sensitive.

Once the employee information is entered, set the employee's access levels. The default access level is

for no access to ATS.

. Employee Administration

Employee Administration

Employee Info

First Name: ‘Mary

Last Name: ‘Dae

Middle Initial-

Barcode: [E002

Log in Name: [MARYDOE
(Min. Scharacters)

ot [

Pass)
(Min. 5 characters)

Phone: |

Alt. Phane: |

E-mail- |

Notes: - Status
« Active
 Inactive

M save | @ cance

Access Levels

Asset Administration - applies to
activities associated with creating and
editing asset data.

Asset Administration

“ No

© View © Edit

Asset Reservation — applies to the

Asset Reservation

' No

Asset Check In / Check Out

 No

& View " Edit

activities where an individual may reserve
an asset for a period of time.

& Edit

Asset Support Administration

# No

= View  Edit

Asset Check In/Check Out- applies to

Employee Administration

& No

Member Administration

& No

 View  Edit

activities associated with assigning assets
to an individual or location, or returning

= View  Edit

assets to storage.

Asset Support Administration - applies to activities that support the overall asset process. This will

include managing facilities, locations, asset types, classifications, and conditions.

Employee Administration— applies to activities associated with managing employee information.
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Select the access level appropriate for the employee in question and then select the OK button.

Member Administration — applies to activities associated with creating and editing member
information.

To save the employee information, including the access level changes, select the Save button. Selecting
the Cancel button will leave the present process without saving the employee information.

If the employee logged into the system only has view rights to Employees, the “add”, “edit”, and
“delete” buttons will not be available. Instead, a “View” button will be available to allow the user to
look at employee information without changing any data.

To leave the process, select the in the upper right corner of the screen.

If you have the Access version of ATS, this option is used to periodically repair, compact, and backup the
ATS database. To determine if you have the Access version of ATS, go to the Help tab—=>About and the
header of the box will say “About (Access)”

heackup / Compact Database = || Itis possible that the Access database can get corrupted.
Backup | Compact Database Compacting the database may repair the damage. In
This procedure will repair many database errors as well as reduce addition, a preViOUS CompaCt Operation Wl“ have Created a
overall database size by removing deleted and duplicate records. .
It will also create a backup copy of the current database in the baCkUp of the database that can be used if the current

‘dbbackup’ folder. . )
database is corrupted beyond repair.

The system will Iseep the last 3 backup copies of the database.
fhelcideticiibatetid, The system will retain three backup copies of the database
To repairfcompact the database, click the Compact Database button. in the dbbackup f0|der. Backing up frequently W|” minimize

the loss of data if the current database is corrupted

beyond repair.

MS Access does not automatically remove data that is deleted by the system. Compacting the database
will remove data that has been deleted. This will reduce the size of the database file and improve
performance.

To compact the database, select Compact Database under the File menu. Then select the Compact
Database button.

The system will compact, repair, and backup the database and when complete, the Compact Database
screen will disappear.
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i/ Change Password &

Change Password

Enter current User Name and Password.
Then follow the on-screen instructions.

Enter New Password:
Change Password

Type in your new password again. If the password matches the S =)
new password you typed earlier, the system will save the new e i)

. . Enter current User Name and Password.
password and the Change Password screen will disappear. Then follow the on-screen instructions.

If the password does not match the password typed in earlier,
the system will state the passwords do not match and ask if you

wish to try again.

If you answer yes, the screen will be returned to the state above

A user currently logged into ATS may change their password at
any time. Select Change Password from the File menu and the
screen at left appears.

Type in your current user name and password and then select the
Change password button.

Passwords must be between 5 and 10 characters long.

Type in your new password and then select the Change Password
button.

User Name:
Password:

Change Password

and you may try to type the second password again.

Log in temporarily is a function used in order to perform some function that the current user may not

# LogIn Temporarily

% complete without the current user having to exit the

Log In Temporarily

Enter your user name and password to temporarily login.

User Name: ‘

Password: ‘

If:éj : Login

program.

Select Log In Temporarily under the file menu. The screen at
right will appear. Enter your user name and password, and
then select the Log In button.

The banner on the main screen will turn red. As long as
someone is temporarily logged into the system these
conditions will remain.

When the user temporarily logged in logs out by selecting

the Log Out button, the main screen will return to normal and the original user is the current user.

ATS
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PURGE HISTORY

Enter Date &
If you would like to purge all history before a certain date, you : —
. . All toal history records prior to this date will be purged. 0K
can enter a specific date and then click OK. WARNING!! Be very Please srisr  date: —

careful with this feature, when you click OK, all asset history

records will be purged for good.

HANDHELD CONFIGURATION

The Handheld Configuration screen is used to select the handheld device. This version of ATS currently
supports Windows Pocket PC and CE handhelds.

@ Handheld Configuration 52 || Toview the Handheld Configuration
screen, click the File menu item and select
Handheld Configuration Handheld Configuration.
(Other)

. Pocket PC devices require Microsoft
Datalogic Memar

Datalogic Skorpio ActiveSync (for Windows XP) or Windows
Honeywell Dolphin 6100

Intermec CK71 and CNT0 Mobile Device Center (for Windows Vista
LXE MX8 or newer) to communicate with ATS.

Further instruction on how to use the

Handheld device and configuring it with
Handheld Data Folder: [\Honeywell\ the Asset Tracking System will be
. 4 discussed later.

IMPORTS

Each import has specific instructions included on the import screen that delineates data formatting
requirements along with any special instructions you may need. Imports are available for the following:

[ Import Employees Bg
import Employees Import Assets: Allows the import of asset data into the
This import['s Tor NEW employees only. - ATS SyStem'
It does MOT update existing employee records. I
The column layout of the expected import file is as follows: E .
Import Employees: Allows the import of employee data
*Mame, *Barcode, *Facility, Log in Name, Password, Phone, Alt. Phone, . L. X .
E-mail, Notes, Master Access, Tool Access, Check In / Out Access, B into the Em pIOyee Administration table. The Import even
Transfer Access, Reservation Access, Member Access, Employee Access,
Tool Status Access, Support Access, Maintenance Access, Status allows for the gra nting of SpeCiﬁC access r|ghts to the
- The file format is TXT (Tab delimited). various fU nctions in ATS
- The layout will be based on column position. not column headers. :
- Accolumn header row, if detected (based on the words BAR CODE ar <

Print Instructi . . . .
- Import Locations: Allows the import of location data into

‘ m the ATS system.

Backup the database
I; View
2+ LogFile

/= (File menu) before
importing new data
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CHECK FOR UPDATE

After logging in, select Check for Update on the Help menu. Major updates may require you to contact
GigaTrak and receive a special download. Access to the Check for Update function is only available
when the ADMIN login is used. You must have a current Support Agreement in place to download
updates.

ABOUT

The “About” section tells you which version of the software you currently have as well as some brief
licensing information. This area also specifies which database the software uses for your system. This
section is particularly helpful to the support and training teams when working to assist you on any
guestions you may have regarding the ATS system.

ACCOUNT ADMINISTRATION
Account Administration is used to keep track of the account numbers that are used to purchase assets.
Account numbers are not required to use ATS.

 Account Administration =S To begin the process, select

Account Administration Account Administration from the

||:|'-.:',-1| Add l l/ Edit l ’% Delete

Account Number: |1UUD

Support menu.

To Add a new account, select the
Add button. Enter the Account
Number (required field) and a

Description |Accoulmng Department

description (optional), then select

s i
the Save button.
Account Number Description Active?
_ i
2000 — Vou To Edit an Account, select the
3000 Maintenance Department Yes Account of interest and then select
4000 Administration Department Yes

the Edit button. Modify the
information as desired. Select the
Save button to save the Account
changes.

To Delete an Account, select the

Account to be deleted and then
select the Delete button. The system will check to see if the account is tied to an asset. If so, the
system will not allow the Account to be deleted. You may inactivate the Account to prevent it from
being assigned to an asset in the future if you desire.
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ASSET CONDITION ADMINISTRATION

Assets may be assigned a Condition, which indicates the usefulness of the asset. To access this process,
select Condition Administration under the Support menu.

ﬁ Aszet Condition Administration @

Asset Condition Administration Each Condition has a name and

‘I#—.:? Add ‘ ‘L// Edit ‘ ‘%Delete

Condition: [Excellent Condition name may be up to 20

Description. In addition a Condition may

be designated as Active or Inactive.

Description: |New or nearly new characters and is required. This name
must be unique.

ol o
Condition T Active? Description may be up to 80 characters
w long and is not required
Good minimal damage Yes
MNeeds Repair ltem needs maintenance Yes
Poor Damage with functionality problems Yes

A Condition set as active may be assigned
to an asset; a Condition set as inactive will
not be available for assignment to an
asset. Setting a condition as “inactive”
minimizes clutter, but retains historical

information tied to each condition.

To add a new Condition, select the “add” button, enter the new Condition (name) and Description, and
click “save” button to save the new condition.

To edit an existing Condition, select the Condition to be edited and then select the Edit button. Modify
the Condition (name), Description, or Status (Active vs. Inactive). Select the Save button to save the
changed Condition.

To delete a Condition, select the Condition to be deleted and then select the Delete button. The
system will check to see if the Condition is assigned to an asset. If so, the system will not allow the
Condition to be deleted. You may inactivate the Condition to prevent it from being assigned to future
assets if you desire.
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Asset Support Administration is used to administer Classifications and Types. To access this process,
select Asset Support Administration under the Support menu. Asset Support Administration has two
tabs: Classification and Type.

CLASSIFICATION

The first tab is Classification. Assets may be assigned a Classification to organize them in groups.

[ Asset Support Administration @

Asset Support Administration
Each Classification has a name

Add /\ Edit Delete Cj Print List . ) . .
Il%g l I ] [% l ] (Classification) and Description. In
Classification (F1) Type (F2) User Defined Fields (F3) Maintenance (F4) .. . .
addition, a Classification may be
Classification: ‘Electrcnics . . .
B designated as Active or Inactive. A
Description
classification assigned as active may be
& e tied to an asset; an inactive
Classification Description Active? classification may not be tied to an
m— 4
Furniture Yes asset_

A classification may be set as inactive
to reduce clutter yet retain important
historical information.

e (Classification (name) may be up to 20 characters and is required. The Classification (name) must
be unique (i.e., no other Classifications may have the same Classification (name).
e Description may be up to 80 characters long and is not required.

To add a new Classification, select the Add button. Enter the new Classification (name) and Description
(optional). Select the Save button to save the new Classification.

To edit an existing Classification, select the Classification to be edited from the listing and then select
the Edit button. Modify the Classification (name), Description, or Status (Active vs. Inactive). Select the
Save button to save the changed Classification. Select the Cancel button to exit the Classification
change without saving the changed Classification.

To delete a Classification, select the Classification to be deleted and then select the Delete button. The
system will check to see if the Classification is assigned to an asset. If so, the system will not allow the

Classification to be deleted. You may inactivate the Classification to prevent it from being assigned to

future assets if you desire.

To leave the process, select the [XI in the upper right corner of the screen.
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TYPE

The second tab is type. Type is a subclass of Classification. Each Classification can have several Types.
In addition to grouping assets under a Type, the Type will also set the default depreciation period for

.7/ Asset Support Administration == ) .
—— — assets assigned to it.
Asset Support Administration
l'f?}j Add | [ 7 i ] |${ Delete [@ Print List Each Type has a name (Type), Description, and
Classification (F1) Type (F2) User Defined Fields (F3) Maintenance (F4) Depreciation period in years. In addition a
Classification: [ Eleciranics o] - - Type may be designated as Active or Inactive.
: [Camera ' () . .
e A Type set as active may be assigned to an
Description . . .
asset; a Type set as inactive will not be
Depreciation Years . .
’ e - available to be assigned to an asset.
Description Dep. Active? |Due Date
IR | A type may be set as inactive to reduce
Yes None . . . .
Yo N clutter, yet retain important historical
Yes None
information.

e Type (name) may be up to 20 characters and is required. The Type (name) must be unique (i.e.,
no other Types may have the same Type (name)).

e Description may be up to 80 characters long and is not required.

e Depreciation may be up to 255 years and is not required.

To add a new Type, select the Add button. Select the appropriate Classification for the new Type.
Enter the new Type (name), Description, and depreciation period. Select the Save button to save the
new Type.

To edit an existing Type, select the Type to be edited and then select the Edit button. Modify the Type
(name), Description, Depreciation, or Status (Active vs. Inactive). Select the Save button to save the
changed Type.

To delete a type, select the Type to be deleted and then select the Delete button. The system will
check to see if the Type is assigned to an asset. If so, the system will not allow the Type to be deleted.
You may inactivate the type to prevent it from being assigned to future assets if you desire.

To leave the process, select the [XI in the upper right corner of the screen.

USER DEFINED FIELDS

The third tab is the User Defined Fields. Fields can be added specific to an asset “Type”. When new
assets are added to the system, the added fields are displayed in the Asset Information screen for user
entry.
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[% Asset Support Administration

g

Asset Support Administration

[% Add | [L// Edit ‘ ’% Delete

I O Print List]

Classification (F1) T Type (F2) T User Defined Fields (F3) Maintenance (F4)
Classification: | Electronics -
Type: | Computer M
Field Name: [Kind
ol C
Field Name Active?
MAINTENANCE

After selecting the appropriate Classification
and Type for the asset, a listing of the current
User Defined Fields is displayed. Each field
has a name and may be designated as Active
or Inactive. Setting a User Defined Field to
inactive does NOT remove the data already
recorded for any asset of that type. It will
not be displayed on the Asset Information
screen. Returning the asset to active will
restore prior data for each asset of that type.
. The Field Name may be up to 50
characters and is required.

. A Field Name set as active will be
assigned to each asset of that Type.

. A Field Name set as inactive will not be

available.

The forth tab is Maintenance. Each “Type” of equipment may be assigned a group of specific

Maintenance items with a preset interval in months for required performance. In addition, a “Repair”

maintenance item may automatically be inserted when a new “Type” is created. This is created in

Setup Options.

Each maintenance item has a Description and Special Instructions. In addition, a maintenance item

may be designated as Active or Inactive. Setting a Maintenance item to inactive may be useful to

reduce clutter when assigning Maintenance item to assets, yet it remains in the database for historical

r,)( Asset Support Administration |§|
Asset Support Administration
) =
Add Edi % Delet Print List
| l{-%l l \ L// qu/ ete O rint Li
Classification (F1) | Type (F2) | User Defined Fields (F3) | e (F4)
Classification: | Electronics -
Type: | Computer hd
Maintenance Description: |REpair
Special Instructions
Interval: (0 Months
ol (@]
Maintenance Description Special Instructions Interval Active?
Repair o Jves |
Run Diagnostics Scan 2 Yes
Update Software 2 Yes

ATS USER MANUAL SCHOOL EDITION

purposes.
. The Maintenance Description may be
up to 50 characters and is required. The
Description must be unique (i.e., no other
Description may be the same).

. Special Instructions may be up to 255
characters long and is not required.

o A Maintenance item set as active may
be assigned to an asset of that type.

. A Maintenance item set as inactive will

not be available.

To add a new Maintenance Item, select the
Add button. Enter the new Maintenance
Description. Enter any Special Instructions.
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Select the Save button to save the new Maintenance Item.

To edit an existing Maintenance ltem, select the Maintenance Item to be edited and then select the

Edit button. Modify the Maintenance Description, Special Instructions or Status (Active vs. Inactive).

Select the Save button to save the changed Maintenance Item.

To delete a Maintenance Item, select the Maintenance Item to be deleted and then select the Delete

button. The system will check to see if the Maintenance Item is assigned to an asset. If so, the system

will not allow the Maintenance Item to be deleted. You may inactivate the Maintenance Item to

prevent it from being assigned to future assets.

To leave the process, select the [XI in the upper right corner of the screen.

BJ Facility Administration =]

Facility Administration

) (2] [

F%cilily
Facility Name Active? Support menu.
Main School Yes

Zip Code- up to
10 characters
long, but is not
required.
Notes-up to 255

characters long, but is not required

To Add a new facility, select the Add button. Enter the
information as desired. Select the Save button to save the
new Facility. Select the Cancel button to exit the Facility
addition without saving the new Facility.

To Edit a Facility, select the Facility of interest and then
select the Edit button. Modify the information as desired.
Select the Save button to save the Facility changes. Select
the Cancel button to exit the Facility addition without saving
the Facility changes. In either case the main screen, shown
at the beginning of this section will appear. If the Facility
was saved, the changed Facility will appear on the Facility
list.

Facilities are the upper hierarchy of locations. In other
words, locations are tied to a facility. Due to this structure,
at least one facility is required by the system.

To begin the process, select Facility Administration from the

Facility information consists of:

Unique Name- up to 40 characters and is required.
Address - up to 40 characters long, but is not required.
City- up to 40 characters long, but is not required.
State-up to 2 characters long, but is not required.

i Facility Administration (=]

Facility Administration

l H Save ’@Canc&l
WELWCHIACME Central Warehouse|

Address: 442 Central Circle

City: |Eve nywhere

State: |WI
Zip: |55444

Notes: -

Status

@ Active ¢ Inactive
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To delete a Facility, select the Facility to be deleted and then select the Delete button. The system will
check to see if a location is tied to the Facility. If so, the system will not allow the Facility to be deleted.
You may inactivate the Facility to prevent a location from being assigned to it in the future if you desire.

To leave the process, select the [X] in the upper right corner of the screen.

- Funding Source Administration @

Funding Source Administration is used to keep track of the agency

Funding Source Administration

that provided the asset. The Funding Source is not required to use

ATS [% Add ] ‘;_/\ Edit ‘ ‘% Delete

Funding Source

To begin the process, select Funding Source Administration from

‘C:a:\la\ Budget

the Support Menu. The screen will appear.

(o (o

Activities available for Funding Source are: Description Active?
Capital Budget Yes
-Adding new Funding Source dozEiiEli e

-Editing existing Funding Source
-Deleting Funding Source

Adding a New Funding Source:

To add a new Funding Source, select the Add button. Enter the description, then select the Save button.
Select the cancel button to exit the Funding Source addition without saving the new Funding Source.

Editing an Existing Funding Source:

To Edit a Funding Source, select the Funding Source of interest and then select the Edit button. Modify
the information as desired. Select the save button to Save the Funding Source changes. Select the
Cancel button to exit the Funding Source addition without saving the changes.

Deleting an Existing Funding Source:

To delete a Funding Source, select the Funding Source to be deleted and then select the Delete button.
The system will check to see if the Funding Source is tied to an asset. If so, the system will not allow the
Funding Source to be deleted. You may inactivate the Funding Source to prevent it from being assigned
to an asset in the future if you desire.

To leave the process, select the [XI in the upper right corner of the screen.

Location Administration is used to manage the locations to which assets may be assigned. It displays all
the locations that exist in the system that are tied to the facility selected.

To add a new Location, select the Facility to which it is to be added and then select the Add button.
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=8 Location Administration

Location Administration

] (2] (o

.,';.- Change Responsible

= .
l Export To File individual

O Print Barcode List

[

Facility: ‘Mam Office j
Location Barcode Responsible Individual | Storage? | Active?
Office 101 User, Admin - No
Office 102 Lo02 User, Admin - No Yes
Office 201 Loo3 User, Admin - No Yes
Office 202 L004 User, Admin - No Yes
Storage L005 User, Admin - Yes Yes

5 rows found

rather than usage.

4 Location Administration

Location Administration

Facility: ‘Mam Office j

Location: (G180

Barcode: [L001

(+ Checkout/Usage Location

(" Storage Location

Responsible Indwvidual:
User, Admin j

Status

@ Active " Inactive

Add New Facility

A Add New Employee

Enter the location information as desired:

Facility - defaults to the facility selected on
the main form but may be changed.

Location - may be up to 50 characters and is
required. Must be unique to each location.

Barcode - may be up to 20 characters long
and is required. A barcode for an asset,
location, or employee cannot be the same.
Checkout/Usage Location -location that
assets can be checked out to.

Storage Location - location used for storage

Transfer Location - location that assets
transfer to.

Responsible Individual - employee that is
responsible for the assets at the location.
This is not required. If the responsible
individual is not in the system, you may go
directly to the Employee Administration
process by selecting the Add New Employee
button.

Notes - may be up to 255 characters long
and is not required.

To edit a Location, select the Facility
containing the Location, select the
Location of interest and then select the

Edit button. Modify the information as desired. Select the Save button to save the Location changes.

To delete a Location, select the Location to be deleted and then select the Delete button. The system
will check to see if an asset is tied to the location or the Location is being used in a history record. If so,

the system will not allow the Location to be deleted. You may inactivate the Location to prevent an

asset from being assigned to the Location in the future if you desire.

EXPORT LIST TO FILE

This button will export information for the displayed locations to a tab delimited text file.
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CHANGE RESPONSIBLE INDIVIDUAL

Change Responsible Individual will change the responsible individual for all selected locations on the
screen. Display and select the locations that you want to change. To select multiple locations, do one
of the following:

e Dragthe mouse over the locations desired while holding down the left mouse button.

e Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

e Hold down the Control (Ctrl) key and select the locations you wish to change by left clicking on
each one with the mouse.

After the locations are selected, click the Change Responsible Individual button. A screen will appear
where you can select a new Employee. Select the new Employee and click the OK button.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed location barcodes that can be used for scanning.
When the Print Barcode List button is selected, a pop-up window will appear where you can set the
barcode row height. This allows you to control the space between barcodes on the list. The minimum
row height is 0.5 inch.

PRINT LOCATION LABEL

To print a Location label, select the location(s) to be printed and then select the Print Label button. If a
label printer has been selected and if a default location label has been designated (see Label Designer
in this manual), the label(s) will be printed.

For label printing, multiple locations may be selected. To select multiple locations, do one of the
following:
e Drag the mouse over the locations desired while holding down the left mouse button.
e Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

Hold down the Control (Ctrl) key and select the locations you wish to print by left clicking on each one
with the mouse.
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The Maintenance/Repair Provider Screen allows you to standardize the name of each provider who
services your equipment. You can add new provider names, edit existing names and delete providers
not used for maintenance.

To start the process, select Maintenance/Repair Provider Administration from the Support menu.
To add a new provider, select the Add button.

Provider Information consists of:

" Maintenance / Repair Provider Administration =

Unique Name---up to 50 characters and is required.

Maintenance / Repair Provider Administration

] (2] (e

Provider

Address---up to 100 characters, but is not required. If an

address is entered, it will appear on Maintenance Request

Report.
Provider Name Active?
Mike's Fumiture Repair Vo City---up to 40 characters, but is not required.

Total Cleaning Systems Yes

State---up to 2 characters long, but is not required.
Zip---up to 10 characters long, but is not required.
Contact---up to 100 characters long, but is not required.
Notes---up to 255 characters long, but is not required.

Enter the information as desired. Select the Save button to save

the new provider. Select the cancel button to exit without

saving.

To edit a provider, select the provider of interest and then select the edit button. Modify the
information as desired. Select the save button to save the provider changes. Select the cancel button to
exit without saving the changes.

To delete a provider, select the provider to be deleted and then select the delete button. The system
will check to see if an asset maintenance record is tied to the provider. If so, the system will not allow
the provider to be deleted. You may inactivate the provider to prevent its use in the future if you
desire.

To leave the process, select the in the upper right corner of the screen.

ATS USER MANUAL SCHOOL EDITION 26



The Label Designer is used to design labels for the various processes in the system that print barcodes.
There are three process which print labels: assets, locations, and employees.

" 4 Label Designer N

— g These processes can be
Design Type Current Label Designs ~ [TTrmmmmmmmmmemommemmmmeerenes Selected |n the DeSIgn Type
= figsai ample AssetLabel (Defaul .

e B—— section of the form,

¢ b located in the upper left

[ Save As Default Asset Label ]
corner.

Element Options

EILIJUM -1 (0@ To design a label, first

Al 12 Regular select the design type.

[ Wrap Text? [~ Center Text?

oz The data source list will
(Label Caption only) A

Account Description Label Size . . .
e = e contain the possible fields
Asset Description v . .
Labemm: ks that may be included in the

Orientation Mode
| - label.
m Dot . S — Doa ¢ Landscape @ Design ¢ Print
lew iete ave ave sign

[ Design X Design [ [ﬂ Design [ [a' As... Label Printer: HP Color LaserJet Pro MFP M476 PCL 6 o4

The Current Label Design list will contain labels that have already been created for the design type. The
list currently contains a sample asset label. When one of these labels is selected, the box on the right
will display the label design, as indicated above for the sample asset label.

To create a new label, select the Design type and then select New Design button. Set the label size
(width and height in inches). Set the label orientation (Portrait or Landscape). For Portrait, the height is
vertical on the screen. For Landscape, the height is horizontal on the screen.

There are 6 different elements that may be placed on the label. They are (left to right): text, barcode,
horizontal line, vertical line, box, and a graphic.

ADDING A TEXT ELEMENT

Select the Text (T) button in the Element Options panel. Select (Label Caption only) in the Data Source
box, and type a label caption in the Label Caption textbox. You can select Wrap Text or Center. To set
the font style and size, click the Font button. Click the Add to Label button. The text element will
appear in the upper left corner of the label design. Drag it to the desired position on the label.

To edit the text caption or font after a text element has been placed in a label design, right click on the
element and choose the option desired.
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ADDING A DATABASE FIELD TEXT ELEMENT

In the Data Source box, select the desired database field. You can select Wrap Text or Center. To set
the font style and size, click the Font button. Click the Add to Label button. A sample of the data will
appear in the upper left corner of the label design. Drag it to the desired position on the label. When
the label is printed, the actual data for that field will be printed on the label.

To edit the text caption or font after a database field text element has been placed in a label design,
right click on the element and choose the option desired.

ADDING A BARCODE ELEMENT

Select the Barcode button in the Element Options panel. Select (Label Caption only) in the Data Source
box, and type a label caption in the Label Caption textbox. You can select Center. Select the barcode
font and size desired. Click the Add to Label button. The text will be added to the label in the barcode
font. Drag it to the desired position on the label.

If a database field is needed as a barcode, select the field from the Data Source box, and add it to the
label. When the label is printed, the actual data for that field will be printed on the label as a barcode.

ADDING A HORIZONTAL LINE ELEMENT

Select the Horizontal Line button in the Element Options panel. Click the Add to Label button. A
horizontal line segment will be added to the label design in the upper left-hand corner. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the right end
of the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired
length.

ADDING A VERTICAL LINE ELEMENT

Select the Vertical Line button in the Element Options panel. Click the Add to Label button. A vertical
line segment will be added to the label design in the upper left-hand corner of the label. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the bottom of
the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired length.

ADDING A BOX ELEMENT

Select the Box button in the Element Options panel. Click the Add to Label button. A box will be added
to the label design in the upper left-hand corner. Drag it to the desired position on the label. To
change the size of the box, place the mouse cursor over the lower right-hand corner of the box. When
the cursor changes to a double arrow, click and drag the endpoint to the desired size.

ADDING A GRAPHIC ELEMENT

Select the Graphic button in the Element Options panel. Click the Find Graphic File button to find a file
on your computer to place on the label. File types supported are bmp, gif, jpg, wmf, and ico. Click the
Add to Label button. The graphic will be added to the label design in the upper left-hand corner. Drag
it to the desired position on the label.
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Graphic elements are resizable. Save the label design before attempting to resize a graphic element.
Right click on the graphic in the label and select Resize Graphic. A Resize Graphic box will appear above
the Label Size box. Enter the desired Height and Width (in inches) and click the OK button. It may be
possible to enter a size that causes the graphic to disappear from the label design. If this happens,
select a different label design. When prompted to save changes, respond NO to the prompt. Then go
back to the label design and try again.

DELETING A LABEL ELEMENT

Select the element to be deleted from the label design. Click the Delete Element button, or press the
Delete key on the keyboard. Elements can also be deleted by right-clicking on the element and
selecting Delete from the popup menu.

DELETING A LABEL DESIGN

To delete an entire label design, select the design from the Current Label Designs list. Click the Delete
Design button at the bottom of the screen.

SAVE AN EXISTING DESIGN AS A NEW DESIGN

Time may be saved by copying an existing label design and modifying it. Select the design from the
Current Label Designs list, and click the Save Design As button at the bottom of the screen. Enter a new
design name and click the OK button. Design names must be unique.

VIEWING/PRINTING A LABEL

The work space on the right-hand side of the screen provides a feel for how your label will print. If you
need to view exactly how your label will print, click on the View button with the Mode setting set to
Design. An exact replica of the label will appear. To print the label on your label printer, change the
Mode setting to Print, enter the number of labels you want to print and click the Print button.

To save a label design as default for a specified process, select the Design Type (process), and select the
label design from the Current Label Designs list. Then select the Save as Default button.

When a label is set as the default label, the word "Default" will appear after the label design.

To leave the process, select the [XI in the upper right corner of the form.
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The Label Setup screen allows the printing of barcode labels in sequence. This feature is only available
for the Asset Design Type. This allows printing of asset barcode labels that can then be attached to
assets, and entered on the Asset Information screen.

— =™ Any Asset Label design can be
Label Setup III\IIIIIIELy:! .
— e chosen, it does not have to be

L the “Default” design. The label
o design must contain the barcode

[ SaveAsDefaulAssetlabel | . . .
PrintLabel | design element or it will not

Sequence

print. Note that if the label
design contains an asset
description, the description will

Width  Height be blank. They have not yet
o

been assigned to an asset.

Mode
=

- & Design ¢ Print View

Label Printer- HP Color LaserJet Pra MFP M476 PCL &

On the Label Setup screen, select
the Asset Design Type, then
select the Print Label Sequence button. The screen below will be displayed.

v2.4

A three (3) character prefix can be entered if desired. The Start Number will initially start at 00000001
but can be changed to any number desired (up to 8 characters). Enter the number of labels to print in
the How Many box and select the Start button.

The system will check the barcodes already assigned to assets in the database to be sure that the

barcode to be printed is unique. If it is unique, the label will print. If it is not unique, the number will
be skipped, and the next number in the sequence will be checked. If the number of characters in the
Start Number is incremented beyond 8 characters, a message will be displayed and printing will stop.

After printing starts, a Cancel button will appear. Selecting the cancel button will stop the printing
process. Pressing the Esc key on the keyboard will also stop printing.

The prefix and the last barcode number printed will be saved in the database. These values will then
appear the next time the Print Label Sequence function is used. The Start Number will automatically be
increased to the next value.

To exit the Print Label Sequence function, select the Close button.

The Asset Management process is started by selecting the Assets button on the main toolbar, which
displays the screen below:
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Three tabs are displayed. The first is the “Find” tab, which is used to view assets and print lists of
assets. The tab is controlled by sections on the upper part of the form, allowing you to filter and view
those items by:

T e Tt sy
FieSopp o

o 4 EETSEN gl o
e Funding Source
e Account

e Search by Criteria
+ [DueDate |Funding Soure  Acctum Y C|assification

e Type

e Condition

e Status

v

ight.cick to ew image (f assignod).

[———— Ostsbase: C:0gaTrakAssetTackng Systemnsts o
T —_—

Several key aspects are available on the form. As an example, selecting the Reset button will return all
selections to All. In addition, the Asset list can be sorted by one of its columns by clicking on the
heading of that column. A second click will reverse the sort order of the items in the listing.

SEARCH FIELD

Groups of assets can also be displayed by typing words in the Search Description box, and then
selecting the Extract button. For example, if you type in the word “chair” into the box and click extract,
only the assets that have the word “chair” in their description will be displayed. If a location is also
selected, only assets that are located at the particular location and have the word “chair” in the
description will be displayed.

ADD TO LIST

The Add to List button can be used to build a custom list of assets. When selected, it will appear to
remain depressed. When in this mode, assets that are extracted will be added to the list of assets
already shown on the screen, rather than clearing the screen first. You can continue to change the
selection filters and extract the assets you need to build your list. The list can then be printed or
exported. Clicking the Add to List button a second time will return the Extract Data function to its
normal mode.

PRINT LIST

To print the Assets in the list, select the Print List button. A report is displayed and if the default printer
is set, the Assets displayed on the screen will be printed when Print is selected. You may also save it as
a PDF or Email the report directly.
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PRINT BARCODE LIST

Print Barcode List will print a list of the displayed asset barcodes that can be used for scanning. The list
will include the Barcode number, Barcode, Description, Product Number, and Serial Number. When the
Print Barcode List button is selected, a pop-up window will appear where you can set the barcode row
height. This allows you to control the space between barcodes on the list. The minimum row height is
0.5 inch.

EXPORT LIST TO FILE

Export List to File will export information for the displayed assets to a tab delimited text file.

ASSET IMAGE

If an image is assigned to an asset, a thumbnail picture will be displayed in the Description column of
the grid. The thumbnail display can be turned on or off by right-clicking in the grid and selecting “Show
Thumbnail Images” in the pop-up menu. A larger view of the image can be displayed by selecting “View
Image” from the pop-up menu.

Selecting an Asset and then selecting the Asset Information tab, or double-clicking on an Asset will
bring up the Asset Information screen:

Asset information with bold text above is required. Many of the fields listed below are included in the
sub-tabbed section in the lower portion of the form. The available asset information is:

;:j “ < *j- e Classification is a method of grouping
— T g e — = Assets
S e Type is a subset of Classification and a
e second method of grouping Assets
= e Description is up to 80 characters

describing the Asset
e Facility is the building in which the

Asset is located

e Storage Location is the default storage
— = esssmmmmzs |ocation for the Asset

e Funding Source is the agency that provided the Asset

e In Service Date is the date the asset was put into service (defaults to current date)

e Barcode is the barcode that identifies the Asset. You must enter the first asset’s barcode number
manually in a format that all barcodes will use (i.e. AO0001). The system will then automatically
increment the numerical portion of the barcode number one at a time. If you are using pre-printed
barcodes, enter the number seen on the barcode.

e Asset Number is the unique permanent number given to an item for tracking. An asset number is
usually engraved on larger, more expensive items.

e Condition is the physical condition of the Asset. Condition does not apply to binned items.
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e Manufacturer is the manufacturer of the Asset (data entered on the Manufacturer Administration
screen)

e Model is the model number of the Asset

e Serial Number is the Serial Number of the Asset

e Account is the account number used to purchase the Asset

e Status. An Active asset may be checked out, A Retired asset may not be checked out.

PRIMARY DATA SUB-TAB

o Note is up to 255 characters of information about the Asset

e Container allows other assets to be checked out to the container itself (i.e. tool box)

e Binned item is used for small items that cannot be individually bar coded. If the binned item
checkbox is checked, a box will appear to enter a bin quantity. There will also be an option to set the
item as a consumable. Consumable assets can be checked out, but are not expected to be checked
back in (e.g. gloves)

o Check Out determines whether an asset is checked out or not. If it is checked out, the following
information will be available

o By: User to whom the asset is checked out
o Location: location to which the asset is checked out
o Due Date: date the asset is due to be checked in

PURCHASE / WARR. SUB-TAB

e Purchased From allows entry of general supplier information

e  Warrant Expiration Date tracks when a warranty period expires

e Depreciation period in years (does not apply to bin items)

o NOTE: fields relating to Depreciation will not be visible unless the “Show Depreciation”
checkbox is checked on the Setup Options screen.

e Depreciation Type. The system will calculate depreciation based on five methods: Standard Straight
Line, MACRS Half-Year, MACRS Mid-Quarter, MACRS Double Declining Half Year, and MACRS Double
Declining Mid Quarter

o MACRS means Modified Accelerated Cost Recovery System

e Original Value is the cost basis for depreciating the Asset

e Salvage Value is the remaining value of the asset after it has been fully depreciated

e Current Value is the current depreciated value of the Asset (calculated)

e Date for Current Value is the date used to calculate the current value

e Miscellaneous is a user definable field that can be used as desired

IMAGES & DOCS SUB-TAB

Asset Image is the path to a file that contains a picture of the asset. If the image information is entered
and a file is at the proper location, the picture will be displayed in the area to the right of the sub-tab
section. Double clicking on the image will display a full sized image of the picture. In addition, linked
documents, PDF, URLs, and other related files can be assigned to the Asset.
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ADDING A NEW ASSET

To Add a new Asset, select the Add button. All information is cleared and the Save and Cancel buttons
appear.

Find Asset (F1) Asset Information (F2)

— If turned on in System
Classiﬁ::alion:‘ j Barcode: |AUU2U I} Setup’ the system Wi”
Type: ‘ j Asset Number: | i
bosrption conton | e s automatically generate a
Proguct Humber: | a unique barcode for the
Serial Number: | ~ T . . .
- T o sovee | 31 asset if the barcode field is
Slora_ge ‘ j . v | j bl k o
et ank. If a specific barcode
In Service Date: [3/20/2015 B . )
number is needed, just
Primary Data Purchase / Warranty Images & Docs
Assel Image (=) enter the number manually.
View Add File Attached Images & Documents [ Remove |mage Each barcode number must
Unassigned be unique. Select or enter

the required information
(bold labels). Enter the
non-required information if desired. Save the Asset by selecting the Save button. The screen will return

to the original state with the new Asset information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the information displayed that was present prior to selecting the Add button.

EDITING AN EXISTING ASSET

To Edit an existing Asset, select the Edit button. The Save and Cancel buttons appear.

Change the Asset's information as desired. Information with bold labels is required. Save the Asset by
selecting the Save button. The screen will return to the original state with the changed Asset
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

COPYING AN EXISTING ASSET’S INFORMATION TO A NEW ASSET

This is one of the most helpful features when multiples of the same type of asset needs to be entered.
To Copy an existing asset's information to use in creating a new asset, select the Copy button. The
majority of data is copied to a new record. The exception is that the barcode number, serial number
and checkout information is cleared and the Save and Cancel buttons appear.

The system will automatically generate a unique barcode for the asset. If this barcode is unacceptable,
it can be typed over by the user. The barcode entry must be unique. A barcode for an asset, location,
or employee cannot be the same. Change the asset's information as desired and add the new barcode.
Save the Asset by selecting the Save button, the screen will return to the original state with the new
Asset information.
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Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

To Delete an existing Asset, select the Delete button. After asking if you are sure, the system will delete
the Asset.

ASSET HISTORY

Selecting an asset and then selecting the Asset History tab will bring up the Asset History screen below.

. rac P ition -
ile s abels Hel
‘g) & CD Asset Tracking System A 44’1
Assets CheckIniOut || Reserve Reports (el Professional Edition Log Out Quit
& Assets =
Find Asset (F1) Asset Information (F2) Asset History (F3) Asset Maintenance 4
Asset History
Barcods [A0001 | Product Number: [734747 Date: [12123/2014 [...]
Description: [XBLUE Networks X16 Corded Telephone Serial Number: % Purge Selected
System, Charcoal ‘Rsoat's History
From: [EEEEE (... To o205 (L] D Print List
Date Type From Person Location Condition Bin Qty Transaction By Check Out Note
3/12/2015 03:33 PM  Checked out Storage Ofice 101 Excellent User. Admin
3/12/2015 0117 PM__ Added New Asset Storage Excellent User, Admin

The screen displays the history of the selected asset for the date range selected. The system defaults
the date range to the last 12 months. Change one of the dates and select the Enter key or select a new
date with one of the calendar controls and the list will change to reflect the new date range.

To print the history displayed on the screen, select the Print List button.

To remove all history records for the selected asset prior to a specified date, enter the date in the Date
text box and then select the Purge button. All history records for the asset prior to the date specified
will be deleted. The purge button is only available if the “Allow Delete Asset & Purge History” checkbox
is checked on the Setup Options screen.

To leave the process, select the [XI in the upper right corner of the screen.
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Selecting an asset and then selecting the Asset Maintenance tab will bring up the Maintenance

Items/History screen below.

=== The first tab lists the

= | Maintenance/Repair Types

— e e B set up on the Asset
Support Administration

Screen. Maintenance

Asset Tracking System r
Professional Editon R

History can be found on
— ; the second tab. The type’s
e D b s special instructions, the

31212015

intervial required and the
dates last done and due
are shown. If the type is

—— E— mecmmegmens - dUE in the next 30 days, it

will be shown in blue. Note that the service reminder interval (30 days) can be changed in the Setup
Options Screen. Past due types are shown in red. Double-click to select a maintenance action and select
the repair provider, then save. The system will offer to print a Maintenance Request form to send with
the item to the provier. An “open” maintenance record is then inserted into history. When the item is
returned from maintenance, select the open record on the Maintenance History tab by double-clicking.
Now enter the completed date along with notes and a repair cost if appropriate. Once saved, it is now a

completed record in history.

To print the history displayed on the screen, select the Maintenance History tab, then select the Print

Maintenance History button.

To leave the process, select the [XI in the upper right corner of the screen.

The Check Out process is used to check assets out to a user or location. The Check in process is used to
check assets into storage from a user or location. Check Out and Check In can also be performed on the
handheld unit. To start these processes, select the Check In/Out button.
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The Check In/Check Out process is composed of three (3) tabs. The first tab is the Check Out process as
shown below.

& CheckIn/Out =)

‘ @ Reset/ Clear %l Remove ltem

Check Out (F1) Check In by Asset (F2) Check In by Person / Location (F3)

Check Out | [ so

‘ (Lfy Save  Print

@ Location € Employee

Barcode: [ [w] Locatin
ueDate [ ] DTS [ e [

Note: |

Asset Barcode: [=]  Description:

Barcode Description Due Out Condition Person Location Bin Qty Note

User Name: User, Admin Database: Iocalnostiwin_sts

To check out assets:
e Select a Container, Location, or Employee to which the asset will be checked out
o [f desired, enter the due date for the return of the Asset. Enter a date in the Due Date box, or
enter a Default Interval (number of days from today)
e Scan the Asset barcode
o If the Asset is a binned item, a box will appear below the barcode to enter the quantity being
checked out

The asset checkout information will be displayed in the grid. To check out another asset to the same
location/employee and with the same due date, scan another asset barcode.

If no scanner is available, you may enter the barcode information into the barcode text boxes and then
press the enter key on the keyboard. You may also select the find button next to the textboxes to
display a list to choose from.

Items that are entered into the grid by mistake can be removed by selecting the item and clicking the
Remove Item button.

Once items are displayed in the grid, the Out Date/Time can be changed by clicking the Change Out
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all desired assets have been checked out, select the Save or Save/Print button. The check out
information will be saved and, if Save/Print was selected, the system will ask if you wish to print the
check-out report. The system will then clear the check-out list.
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To cancel the check-out process, select the Reset/Clear button. After confirming you wish to reset the
check-out process, the system will clear the check-out list without saving it.

To check in an individual asset, select the Check In by Asset tab. The screen will change as indicated
below.

& CheckIn/Out ==

| @ Reset/ Clear %l Remove ltem

Check Out (F1) Check In by Asset (F2) Check In by Person / Location (F3)

AsstBarcode: | [..] Descripton:

Checkln ‘ [ sow

‘ ([ Save ! Print

Barcode Description Due Return Condition Facility Location Bin Qty {g"c’:tifj"s"“ ' Status

Jser Name: User, Admin Database: localhostivin_ais

To check an asset into storage, scan the asset barcode or enter the asset barcode and then press the
Enter Key on the keyboard. If the asset is a binned item, a box will appear to enter the quantity being
checked in. The check in information will be entered in the list. Condition, Facility, and Storage
Location may be changed. Select the column you wish to change, select the Enter key and pick the new
Condition, Facility, or Storage Location from the list.

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected, the system will ask if you wish to print the check in report.
The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.
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To check in assets assigned to either a container, an employee, or a location select the Check In by
Container / Person / Location tab. The screen will change as indicated below.

To check an asset into storage, first

Checkln [q s Gysoorrm | @ omicon| B samonion
Crppe—r—] select or scan the container,
I e employee or location barcode the
items are being returned from. A
T T N listing of all items checked out to

the container/employee/location
will be displayed. You can then click
the check box for each line item
being returned. Binned item
quantities can also be changed in
the grid if desired.

A Check All option box will check or uncheck all checkboxes for each line item listed. Alternately, you
can scan individual asset barcodes to check the checkbox. You can also change the status to Lost or
Broken for any items checked. The change occurs on Save. If someone returns multiple assets but has
lost others, check-in the returned items first and Save. Then, do a new check-in for the individual and
confirm that the remaining items listed are lost. Check All and Change Status to Lost then Save. The
COPY ROW function allows you to split up binned items being returned so that alternate locations can
be assigned. Verify the QUANTITY is correct before saving!

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected the system will ask if you wish to print the check in report.
The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.

Reserving Assets is a process used to reserve the use of an asset for a specified period of time. This is
not available in the Starter Edition. To start this process, select the Reserve button. The screen below
will be displayed, showing all reservations that fall within the default date range (one month prior to

current date and five months after the current date). The Reserve Assets process is composed of two
tabs.
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The first tab is the Find Reservation process. This is used to view the current reservations for an Asset
or User.

At Feses

Bl

The Reservation type

Find Resenvation (F1) Resenation Admin [F2)
Find Reservations

determines the type of

ReseatonType: [ |
] Bam— reservations to display.

Choose from All, Location, or

Msset Barcode: Al

Employee.

From: [JHER0TE o) TG [

To View the reservations for a

user, scan the user barcode
into the user barcode textbox
and the reservations for the
user in the date range
specified will be listed.

To view the reservations for an
asset, scan the asset barcode into the asset barcode textbox and the reservations for the asset in the
date range specified will be listed.

If no scanner is available, you may also enter the barcode in the barcode text boxes followed by
pressing the Enter key on the keyboard. Another option is to select one of the find buttons, to display a
list from which you may select.

If the reservation type is an employee, there will be Hfrom which you can search a list of users. Enter
an employee barcode and select the Extract Data button. If a matching barcode is found, the employee
will appear in the list. Alternately, you can enter a Last Name and select the Extract Data button. All
employees with the entered last name will appear in the list. Select the user desired and then select the
OK button. You may notice that “All” is available. If you select all, then the reservations for everyone
will be displayed.

Select the cancel button to return to the reservation process without selecting a user.

If the reservation type is a location, there will be Hfrom which you can search a list of locations. If the
reservation type is “All”, the find button will be disabled.

If the reservation type is an asset, there will be \_I from which you can search a list of assets. Select
the asset desired, and then select the OK button. You may notice that “All” is available. If you select all,
then the reservations for all assets will be displayed.

Select the cancel button to return to the reservation process without selecting an asset.

To change the date range for the reservation list, enter a new date and then select the Enter key or set
the date using the calendar control. The list will change to reflect the new date range.

The reset button will return the screen to the default settings.
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The purge reservations button will remove expired reservations from the system. Expired reservations
are those that have a “To Date” that is older than the default “From Date”. They do not appear on the
screen when the reservation form is opened. They can be displayed by setting the “To Date” back to an
earlier date. A message will appear on the screen to confirm the purge operation. It will also show the
number of reservations that will be removed. Respond “yes” to the message to remove the records.

]

@ Reports

The second tab is the Reservation Admin
B infepr process. This is used to add new

reservations and edit or delete existing

Reports

Select Report Report Filters

Bin Tools Below Reorder Paint
Consumable History by Container

reservations.

T . To add a new reservation, select
& h e the Reservation admin tab. Select
=|| the add button, choose between
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Clocsm @ Enoe Scan the location/employee

e .
o [ () e [ AP barcode or select the find button.

e
ToDate: [3232015  [.] Time:
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Check InOut

o

Reports

&
©

Reserve

) Asset Resenvation

Find Resenation (F1) Reservation Admin (F2)

Reservation Admin

— Then scan the asset barcode or
select the asset find button. Set

AssetBarcode: [ EJ Description:
the date range, add a note, and

set the priority as desired. When
completed, select the save button
to save the reservation. The

ggggggggggggg dmn Daiabase: CAGigaTrakiAsset Tracking Systemwin_sis.ndb

screen will return to the find

reservation tab, with the new reservation information. To cancel without saving, select the cancel
button.

To edit an existing reservation, find the reservation in the find reservation tab. Select the reservation of
interest, then move to the reservation admin tab. Select edit and modify the information as desired. To
save, select the save button. The screen will return to the find reservation tab, with the newly edited
information. To cancel without saving, select the cancel button.

To delete an existing reservation, find the reservation in the find reservation tab. Select the reservation
of interest, then move to the reservation admin tab. Select the delete button, and then verify. The
system will delete the reservation. To leave the process, select the [X] in the upper right corner of the

screen.

Each report has a different set of Report Filters that the user can select to create the report results they

desire.
Select the report of interest and the report filters will appear on the right portion of the screen.
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Some reports have an Ignore Due Date greater than a specified date. This is useful if some assets are
checked out to a location or employee over a long period of time, and you do not want these assets to
appear on monthly reports.

When the filters are set, the user then selects the Print Report button. A print preview screen will be
displayed from which the report may be printed, saved as a PDF or Email(ed) (only if Microsoft Outlook
is used).

The Asset Assignment and History Reports (see screen above) give you the ability to Auto E-Mail the
report when desired. Select “Email Report(s)” so that each person gets their own email with their
information. Only employees with an email address record will receive their email report.

If desired, GigaTrak can provide custom reports at your request. These reports will be quoted
separately and automatically added to the Select Report listing when installed.
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Two types of handheld applications are available, batch mode and wireless.

Batch handheld units hold data in a mobile database file that gets transferred back and forth between
the handheld and the host PC. These units will work with both Microsoft Access and Microsoft SQL
Server host databases. The handheld must be docked with the host PC to perform the transfer. The
asset data on the handheld is a snapshot of the data on the host PC. If there are multiple users
changing data on the host database, the handheld data may be outdated in a short period of time.
Therefore, it is important to synchronize the handheld with the host PC often, so that it has current
information.

Wireless handheld units communicate with the host database in real time. This requires the host
database to be Microsoft SQL Server. Your facility will have to have a wireless infrastructure in place
for communication. No data is stored on the handheld.

Communication software must be installed on the host computer. Choose the correct software based
on the operating system of the host computer.

MICROSOFT ACTIVE SYNC INSTALLATION (FOR WINDOWS XP)

1) Locate a copy of the latest version of Active Sync for your computer system. The correct version is
available from Microsoft’s WEB site. Version 4.5 is the latest from Microsoft as of this printing.

2) Look for the installation file (i.e. activesync_setup.msi) and run it. We recommend that you follow
the installation instructions and accept the standard default settings during your install.

3) Leave Active Sync running to install and connect your handheld computer.

NOTE: Some users may use a single PC to connect multiple handheld computers. If this is the case, it
is best to setup your PC to recognize each handheld as a “Guest”. This avoids having Active Sync
loading shared data from your Outlook and other PC applications. To set all connected handhelds as a
Guest, please double-click and run the provided “GuestOnly.reg” file. It will instantly update your
system for future connections.

WINDOWS MOBILE DEVICE CENTER INSTALLATION (FOR WINDOWS VISTA OR NEWER)

1) Locate a copy of the latest version of Windows Mobile Device Center for your computer system.
The correct version is available from Microsoft’s WEB site.

2) Look for the installation file (i.e. drvupdate-x86.exe) and run it. We recommend that you follow the
installation instructions and accept the standard default settings during your install.
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INSTALL GIGATRAK HANDHELD APPLICATION

The handheld application can be found in the Handheld folder of your installation download.

1) Connect the handheld docking station to your computer (typically a USB connection) and plug in the
AC power cable.

2) Put the handheld in the dock and wait for it to sync with the PC.

3) Onthe PC, double-click the handheld setup file for the application you are installing (e.g.,
setup_honeywell_hh.exe).

SYNC WITH HOST PC

The batch handheld must be synchronized with the Asset Tracking application on the host computer
before it can be used. This will load the current tool information onto the handheld.

1) Start the Asset Tracking application on the host computer and select the Download button.

2) If your handheld device is not displayed on the screen title bar, click the Select Handheld button
and select it.

3) Put the handheld in the dock and wait for it to sync with the PC.

4) Select the Sync Data Automatically button to begin the data transfer. Do not remove the
handheld from the dock until the data transfer is complete.

ATS HANDHELD APPLICATION FUNCTIONS

The following describes basic operation of the Mobile Asset Tracking application.

7 ¢ | win-ats

HANDHELD APPLICATION LOGIN

e°
When the handheld application is first started, a user login will be required. Asset #i::,gs\,stem
Scan an employee barcode, or type in an employee barcode and press the S — En:‘gl:,ie -
Enter key. If the barcode matches an employee in the data file, the [ | toam |
employee name will appear under the scan box, and buttons for the
application functions will appear.
fg|winvats o T ue

@ 2014 GigaTrak. Allright d.
g gair:f‘. < igaTral E rights reserve:
Asset Tracking System —
v4,17.0

Scan / Enter Employee Barcode:
[e001 [sow | The user barcode is tied to the records recorded by the handheld. If a

Uses: Smith, Jobi different employee uses the handheld, he/she should enter their barcode

| Check Out ] | Check In | . “ ”
| e before recording records. To change the user barcode, select “Log Out” and
LICH ount BN
: enter in a different employee barcode.

2014 GigaTrak. All rights reserved.

e
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WIRELESS APPLICATION LOGIN

When starting the wireless handheld application for the first time, you will be prompted to enter the
server name in Admin. Select the Admin button to display the Admin screen. You will be prompted to
enter a password when you select this function. The password is admin. If you are entering the
password on the handheld keypad, be sure you are in alpha mode.

WIRELESS APPLICATION ADMIN

Admin
Display the on-screen keyboard and enter the SQL Server Name or IP Address  sgu server Name / 1P Address:

and the database name (typically win_ats). | |

Select the Save button when finished. A message will be displayed to indicate Cetetioe Hopie: |

that the settings have been saved. Select the Back to Menu button. Scan or

I <- Back to Menu | | Save I

enter your employee barcode to log into the application. The main menu
buttons will be displayed as shown above.

CHECK OUT

The Check Out function is used to assign assets to employees or locations.

Scan the barcode of the employee/location that is receiving the assets. If

the barcode matches a record in the data file, the appropriate name will

Check Dut
be displayed under the scan box. Employee/Location Barcode:

|eoo2 |
Doe, Mary
Note:

the asset description will be displayed under the scan box. If the asset is ||

Scan the asset barcode. If the barcode matches a record in the data file,

not a binned item, the check-out record is saved. If the asset is a binned assetbarcode: [ |
item, the “Qty” box will appear, with a default quantity of one. Enter the Asset checked out successfully.

A001 - Compact _[)esk - Left 2-Drawer
appropriate quantity and press the Enter key to save the check-out record.  '@stlec/Emp: Aisle 1
Continue to scan the asset barcodes that will be assigned to the Lidatairecords

employee/location.

| <- Back to Menu I | Reset

The Reset button will clear data from the screen without saving it. It will
not reset data that has already been saved.
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CHECK IN

The Check In function is used to return assets from an

/ ¢ | Check In

" employee/location back to a storage location.
Check In

Change Asset Status: The user can change the Asset Status from a drop-down list at
Asset Barcode: the time of check in. The options are No (change), Lost, or
|a003 |  Broken.

A003 - Gray Rolling Stool

Last Loc/Emp: Shelf 100 Scan the asset barcode being returned. If the barcode matches

a record in the data file, the appropriate name will be displayed
New Storage Location:

lm I under the scan box. The current storage location will be
Shelf 100 displayed. If the asset is being returned to this location, just
press the Enter key. If it is being returned to a different storage
location, scan the barcode of the new storage location.
1 data records ) ) ) . .
If the asset is not a binned item, the check in record is saved. If
| <- Back ko Menu I | Reset I

the asset is a binned item, the Qty box will appear, with a

default quantity of one. Enter the appropriate quantity and

press the Enter key to save the check in record.
Continue to scan the asset barcodes that will be checked in from the employee/location.

Note: Consumable items cannot be checked in. Scanning the barcode of a consumable item will
display the message “Cannot Check In a Consumable”.

The Reset button will clear data from the screen without saving it. It will not reset data that has already

been saved.

AUDIT

The Audit function is used to verify assets that have been
checked out to an employee/location.

Audit
Scan the barcode of the employee/location that is being Employee/Location Barcode:
audited. If the barcode matches a record in the data file, |6002 |
the appropriate name will be displayed under the scan box, ~ D@& Mary
. . Asset Barcode:
and a list of the assets that are currently assigned to that || l

barcode will appear in the list box.

e . . A001 ~ Compact Desk - Left 2-Drawer
Note: binned assets are not audited, and will not be A002 ~ Black Leather Mid-Back Chair

displayed.

If the scanned barcode matches one of the barcodes in the

list, that item will be removed from the list. Continue to

. . 1 dat d
scan the asset barcodes, including barcodes that do not ERIRAR

; ) £- Back to Menu _
appear in the list. When all assets have been scanned, I | E

there may be some items still on the list. Those items can ! E
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be reconciled when the data is downloaded back to the host PC.

The Reset button will clear data from the screen. Tools that were audited will have been saved.

COUNT BIN

/ 4 | count Bin The Count Bin function is used to count the number of binned items in a

Count Bin

Tool Barcode: storage location.
[Toos00 | . .
100500 - Leather Surfaced Work Scan the asset barcode. If the barcode matches a record in the data file,
Gloves . . .
Last Loc/Emp: Shelf 100 the appropriate name will be displayed under the scan box. If the
barcode does not match a bin item, the message “Not a binned item” is
Quantity: dlsplayed
(14 |
Enter the number of binned items counted for that barcode in the
L datarerords | QUANtity box and press the enter key to save the record.
- Back to M Reset
<pecktoens | B The Reset button will clear data from the screen without saving it. It will

not reset data that has already been saved.

f .' | Identify

IDENTIFY

Tool Barcode:
The Identify function is used to display the description of an asset when |

the barcode is scanned. It will also show the last known location or B?;ﬂ”&;ég}';;ﬁ}l‘kee 1/2in Magnum
employee that has it. This is only a lookup function, it does not save Last Loc/Emp: Doe, Mary
data.

<- Back ko Menu 1 data records

DOWNLOAD DATA BACK TO THE HOST APPLICATION

When you have finished collecting data, the batch handheld must be downloaded back to the host PC
application.
1) Start the Asset Tracking application on the host computer and select the Download button.
2) If your handheld device is not displayed on the screen title bar, click the Select Handheld button
and select it.
3) Put the handheld in the dock and wait for it to sync with the PC.
4) Select the Sync Data button to begin the data transfer. Do not remove the handheld from the
dock until the data transfer is complete

The data collected on the handheld will be displayed on the screen. At this point, none of the asset
data has been changed in the host database. Click the Commit button to commit the data to the host
database. Only the rows that are checked in the first column will be committed. The user can check or
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uncheck the checkboxes as appropriate. This will prevent bad data from being committed to the
database.

Some data can be modified before using the Commit function. For a count record, the Qty counted can
be changed by double-clicking the Qty. For a check in record, the Status can be changed by double-
clicking the Status Change column and selecting from the dropdown list. Be sure to check the checkbox
in the first column if you want the data to be changed.

After the Commit function has been performed, it changes data in the host database. The background
of the checkbox will turn yellow for committed items. All handhelds should be synced with the host to
update the data on the handhelds.

DOWNLOAD SCREEN

The system provides for a handheld scanner download process. The user must first configure the PC for
the handheld in use (See Handheld Configuration). The Handheld Configuration screen can be
displayed by choosing the Select Handheld button. The selected handheld device is shown in the blue
banner of the Download screen.

Check in/out records can be mixed with audit records and count records on the handheld unit. When
the unit is downloaded, the records will be shown with the appropriate type displayed. The records
displayed can be limited to a specific type by clicking the appropriate Display Type button.

When a handheld unit is ready for download, select the Download button from the main screen. The
form below is displayed.

g o = Batch handhelds must be loaded
m:f- hows) Mol i v with a reference file before they
T — L AR can be used. Dock the handheld to
T e - P T A E——— e ausme | the host PC and select the Sync

% ot Ofce Maunoice) 00 -—umv'v\u-taiﬂ;lui\xm::?:!s-‘ WO o o Somith b

Mad

o oy e O g m— Data button. Handhelds should be
synced with the PC before each

use to ensure that they have the

St Johm,

@ Od  Smih, ke
Odt  Smih, ke
@ Od  Smih, ke

Out  Ofce 102 Man i) 00

latest data.

If there are download records
stored in the temporary database
table, the grid will display the

& mows found

existing downloaded records. New
handheld records can be added as long as the existing download has not started the commitment
process. If commit has been started or the handheld audit is separate from the existing audit, then the
existing records must be completed and cleared from the database prior to uploading the new
handheld records.

To download handheld data, place the handheld in the downloader, select the Sync Data button, and
follow the on-screen instructions.
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If the download is successful, the grid will be rebuilt with the new records. If the records were
downloaded successfully but there were some problems, the system will provide a message and the
problems will be documented in a log file. This file can be viewed and printed by selecting the View Log
File button. Note that the log file will be deleted whenever a new Sync Data function is performed.

COMMIT DOWNLOAD DATA TO THE DATABASE

There could be some erroneous data in the grid. Therefore the system will only commit those records
that have the Chk column checked. During download the system will check those records where the
audited location matches the expected location, however the user may change the value if desired.
This allows the user to control what records will be loaded into the database. If the audited location
does not match the expected location, the text will be displayed in red.

The Save Changes button will save the changes in the Chk column to the temporary audit table in the
database. This does not change any asset data.

If a checkout record is recorded on the handheld for an item that has a high priority reservation for a
different employee than the one entered on the handheld, the text will be displayed in blue. The Chk
column can be manually checked to allow the checkout of the item to the scanned employee, but this is
not recommended. Always check with the employee who originally reserved the item on the
Reservation screen before allowing the item to be checked out.

The Commit button will save the information in the downloaded records that have been checked to the
permanent portion of the database. The background color of the checkbox will turn yellow after those
records have been committed. The Commit function may be performed several times. Records that
were previously committed will be skipped. Once a Commit function has started, no further downloads
will be accepted from a handheld until the downloaded records are cleared.

IMPORTANT! -- The Commit function changes asset data. A message will appear to alert the user to
sync all handhelds with the PC to update the reference file on the handheld.

The Clear button will remove all records from the temporary download table in the database, making
way for new download information. The system displays a warning message prior to clearing the
records.

The Report button will print a report of the records displayed on the grid.

GigaTrak provides 90-days of telephone support for ATS from the date of purchase. GigaTrak will
advise on installation issues but the customer is responsible for network and SQL Server installation.
Our hours are 9am to 5pm central time Monday through Friday. During this time you are entitled to
any updates or new releases issued by GigaTrak. By purchasing an extended support one, two or three

ATS USER MANUAL SCHOOL EDITION 49



year agreement, these services are extended. Onsite support is available at additional cost. Please call
262-657-5500 extension 2 with any questions.
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